Keysight UXR/MXR/EXR-
Series Real-Time
Oscilloscopes Software

This software is designed to run on:

e Keysight Infiniium UXR-Series oscilloscopes.
e Keysight Infiniium MXR-Series oscilloscopes.
e Keysight Infiniium EXR-Series oscilloscopes.

Version 11.30.00406

Release Notes

Released Date: 25 July 2022
Operating System: Windows 10
Enhancements

» Adds support for new Add-On model numbers. D9110xxxx replaces DI010xxxx and

D9120xxxx replaces DI020xxxx model numbers.
= Adds support for new Core Software model numbers.

= Adds support for two new model numbers for midrange and high-performance
oscilloscopes to replace D90TOPAMA. For midrange, D9110PAMA “Pulse Amplitude
Modulation PAM-N Analysis Software for MXR/EXR/S-Series”. For high performance,
D9120PAMA “Pulse Amplitude Modulation PAM-N Analysis Software.”

= Adds “:CHANnel<N>:PROBEe:SKEW:AUTO” SCPI command description to the

programmer’s guide.

Bug Fixes

= CAN-XL protocol: Not able to select data rate more than 10 Mbps.

= CAN-XL protocol: Decode is not working when “any frame” is selected in trigger dialogue.

=  Protocol is re-decoded when the waveform is moved.

KEYSIGHT

TECHNOLOGIES
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= Normalization not applied properly for FFE equalization taps.

=  Waveform changes with the acquisition stopped when changing time/div or sample rate
with Automatic Probe correction enabled.

=  TVOLT measurement query intermittently returns 9.99E+37.

= Calibrating scope jitter/noise fails.

= Not able to define and enable a User defined voltage probe.

= Marker not displayed on screen for Track RF Marker.

= Start and Stop frequency controls show up in RTSA mode and when selected cause the
software to crash.

= Software crashes when turning on a second channel in RTSA mode.

» Jitter data export doesn’t correlate with Jitter plots on screen. They are not separating
rising and falling edges.

= Voltage offset adjustment intermittent with Zone trigger enabled.

*= Not able to adjust the voltage offset of a differential or common mode channel.

= Infinite persistence leaves waveform ghosts when moving voltage offset.

» Autoscale on a differential channel can cause ADC clipping for cases when the raw
acquisition channels have different voltage offsets.

» FError code 25 returned for “:“MEASure:CLOCK:METHod:ALIGn” SCPI command for Explicit
Clock CDR.

»  The “WAVeform:POINts” query returns extra points in the points value on the initial
invocation.

Version 11.30.00202

Released Date: 26 May 2022
Operating System: Windows 10
Bug Fixes

» Fixes a defect causing the N7005A and MX002XA probes not to be recognized when
connecting the probe to the oscilloscope.
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Version 11.30.00201

Released Date: 17 May 2022
Operating System: Windows 10

New Features and Enhancements

» |Improves the PAM4 FFE Equalization Auto Tap algorithm to produce better results for
closed realtime eyes - D90TOPAMA “Pulse Amplitude Modulation PAM-N Analysis
Software”.

Bug Fixes

» Fixes a crash running Acquisition Board and Backplane Board service tests.

= Fixes a defect with saving a MultiCal calibration to a folder.

= Fixes the install package so that it installs the FTDI drivers.

= Fixes an intermittent issue in the EXR/MXR-series oscilloscopes causing an FPGA
checksum failure during oscilloscope startup.

= Fixes realtime eye measurements for cases when Mask Test is enabled.

= Fixes an implementation issue in the CTLE equalization filter causing more realtime eye
closure than expected.

» Fixes the PCleb CTLE equalization preset filter response.

» Fixes a probe calibration failure on the S-series oscilloscope for the PPOOOTA passive
probe with the PPOO04A auto-probe 1 adapter.

= Fixes a crash that can occur on the EXR/MXR-series oscilloscopes when disconnecting the
PPO0O04A auto-probe 1 adapter.

» Fixes a defect with gated functions where the output of the function is not always
displayed.

= Fixes a waveform shadow display artifact in Roll Mode.

= Fixes a Roll Mode display defect with math functions where the function result is not
displayed unless the source channel is turned on.

» Fixes a defect with the FFT function rendering in the main graticule instead of opening a
new graticule.

= Fixes a defect with “EOT” missing from MIPI D-PHY protocol.

= Fixes a crash on the 8-channel MXR-series that can occur recalling a setup with FFT math
functions enabled on 8 channels.

» Fixes a defect with recalling a setup. The measurement sequence in the measurement
results tab was not being recalled properly.

= Fixes a crash running Offline when using the :WAVeform:DATA command to load data into
a waveform memory.

» Fixes a defect preventing the calibration from running when using the SCPI command,
“MEASure:RJDJ:SCOPe:RJ:CALibrate,” to calibrate oscilloscope jitter/noise.



Infiniium UXR/MXR/EXR-Series Oscilloscope Software Release Notes

= Adds an additional digit of resolution to the frequency axis labels in Hardware DDC mode.

» Adds missing Infiniisim probe files to the
“C:A\Users\Public\Documents\Infiniium\Filters\Probes\InfiniiMax” folder for the Offline
application.

= Adds missing PAM6 and PAM8 demos.

Notes

= Updates the UXR Power FPGA from version 7.21 to version 7.22. This update requires
powering down the oscilloscope and removing the power cord to complete.

Version 11.30.00003

Released Date: 31 Mar 2022
Operating System: Windows 10

New Features and Enhancements

» Adds new measurement to measure undershoot.
» Adds a new feature to save/recall calibration factors. This is intended to support using the
oscilloscope in multiple temperature environments.
= Accelerates plotting of deep-memory waveforms.
» |Improves the responsiveness for voltage offset adjustments.
» |Improves waveform offload speed when Infinite persistence is enabled.
» Adds digital channel support to Roll Mode for MXR/EXR-series oscilloscopes.
= Adds a new Math function to compute the square root of power spectral density.
= Adds a quick copy feature for channels and measurements.
» Adds “Deskew All Signals” functionality for Multiscope.
» Adds Gating function enhancements including the following:
o Zoom box can be used to enable horizontal gating function
o Zoom box can be used to enable a gated FFT
o Includes check boxes to control if the gated signal is displayed and if it opens in a
new graticule.
o Includes button to quickly center the gate
= Adds support for the D9OTOASIA “Advanced Signal Integrity Software” license for
MXR/EXR-series oscilloscopes.
»= Updates to D90TO0DMBA De-embedding software for UXR (1mm and 1.85mm)
Oscilloscopes
o Updates the Precision Cable calibration wizard to allow either the N2806A
Calibration Pulse Generator or the N2125A (Tmm) / N2126A (1.85mm) Calibration
Module.
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o Updates pictures in the Precision Probe/Cable wizard to be more accurate.
Enhancements to the D90OTOPAMA “Paulse Amplitude Modulation PAM-N Analysis
Software”

o Includes a new SNDR setup dialog to support PCle Genb/6, IEEE 802.3ck, and

USB4-V2 which includes
» Linear Fit Pulse Response (LFPR) setup
=  SNDR Input, Pulse Corrected, Error, LFPR waveform plotting
= Sigma-n, Sigma-e, Pmax, SNDR and SNDR Level Mean measurements

o Adds a Gaussian Window for the Vertical Eye Closure measurement

o Increases the Jrms/Jnu report count to 1,000,000 (was 10,000)

Adds support for CAN-XL to the D90OTOAUTP “Automotive Protocol Decode and Trigger
Software” license.
New UXR-Series Aux Power Board FPGA firmware revision 4.1.

New SCPI Grammar (refer to Programmer’s guide for details)

Adds the “:LANE<N>:EQUalizer:DFE:TAP:SEED {OFF|ON}[,<value>]” SCPI command to
seed the initial DFE symbol values

Adds the “:MEASure:PAM:EYE:WSHape {BOXCar|GAUSsian}” SCPI command to select the
window shape for PAM4 eye height and VEC measurements.

Adds the “:MEASure:PAM:EYE:WSDeviation <std dev percent>” SCPI command to select
the window standard deviation for PAM4 eye height and VEC measurements.

Adds several new “:ANALyzer:SNDR” SCPI commands to support the new SNDR
measurement functionality.

Adds the “:LXI:IDENtify[:STATe] <Boolean>” SCPI command, used by LXI to identify the
oscilloscope by popping up an LXI LAN information window that includes the LXI class, LXI
version and MAC Address.

Adds the Waveform Generator option to the *OPT? query for MXR/EXR-series
oscilloscopes.

Bug Fixes

Compensates for VTerm on MX0105A and N5380A/B SMA probe heads.
Restores the previous setup when switching between Scope and RTSA mode.
Adds navigation support for waveform memories 5-8.

Shows the Bode plot as part of the Measurement Report for D90T0PWRA.

Fixes HW Mask Test “stop on failure” for channels 5-8 of the MXR/EXR-series
oscilloscopes.

Updates the Burst Width measurement to work when only one burst is captured.
Disables the Zoom window in Roll Mode while the waveform is rolling.
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= Fixes a defect in the Histogram Top/Base calculation for percent thresholds, which was
causing a bad top/base measurement for deep-memory waveforms not covering the full
screen.

= Fixes a crash that occurs when editing RTSA masks.

» Fixes a channel-channel skew error that occurs when both 4-port Infiniisim and acquisition
averaging are enabled.

= Fixes Infinilum web control Get Image for RTSA mode.

= Fixes the sampling rate selected for High Resolution Auto mode.

= Fixes a defect with loading h5 waveforms into Offline.

» Fixes the skew calibration for the 1169B probe amp with the N5381B probe head.

» Fixes a defect with the acquisition taking too long to complete at low sampling rates.

= Improves the trigger rate in Segmented acquisition mode at slow time/div settings.

= Fixes a measurement defect in acquisition averaging mode causing bad measurement
results.

» Fixes a defect in MultiScope where the sample points between channels could be
misaligned by a sample period.

» Fixes a discontinuity between Tj and Rj/Dj jitter extrapolation.

= Fixes an intermittent hardware DFE plotting error.

= Fixes a defect in the Time Interval Error measurement preventing it from working with
constant clock recovery for PAM3 signals with SSC present.

» Fixes a defect in Offline preventing waveform files from being displayed on startup.

= Fixes a defect in the trigger indicator for deep-memory acquisitions for MXR/EXR-series
oscilloscopes.

Notes

» For the EXR/MXR-series oscilloscopes, this software includes an FPGA update to fix
Hardware Mask Test “Stop on Failure” functionality for channels 5-9. A power cycle is
required to complete the update.

» For the UXR-series oscilloscopes, this software includes an FPGA update for the Aux
Power Board that will require a power cycle to complete.

Known Bugs

=  MXR/EXR “Trigger on Search” does not support digital channels.

=  MXR/EXR Roll Mode may show bad data at the end of the waveform when manual sample
rate is selected, and the roll is stopped before the screen is filled.

= Known defects in MXR/EXR Roll Mode for Math functions.
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Version 11.25.00202

Released Date: 28 Jan 2022

Operating System: Windows 10

New Features and Enhancements

Extends the Bode plot down to 1 Hz (was 10 Hz) - MXR-series oscilloscopes D90TOPWRA
Power Supply Analysis Software.

Adds long run length level measurement for PAM-4 — D90T0PAMA PAM-N Analysis
Software.

Bug Fixes

Fixes a USB4 tunnel USB 3.2 decode defect with Sync detection - D9010USBP protocol
software.

Fixes an error in the differential waveform result running with Infiniium Offline Oscilloscope
Analysis Software — D90TOBSEO and N8900A.

Enables the MSO channel functionality for the Offline Analysis software - D90T0BSEO and
N8900A.

Fixes an Infiniium Offline defect using the :WAVeform:DATA SCPI command to load
waveforms for Phase Noise analysis. The number of correlations is overstated - Infiniium
Offline D99020JITO Jitter, Vertical and Phase Noise Analysis software.

Fixes a channel input overload error on the MXR-series oscilloscope when adjusting offset
with the DPOOOTA probe connected.

Fixes the offset/gain calibration for the MX0025A probe with MXO106A flat probe head.
Fixes an error in the TJ (total jitter) result calculated with Fast Plot enabled and JTF PLL
specification selected - DI020JITA EZJIT Complete software.

Fixes a defect with the FFT vertical marker units showing as V rather than dBm.

Fixes a trigger level error on the MXR/EXR-series oscilloscopes with HFReject trigger
coupling selected.

Fixes a Roll mode waveform plotting error on the MXR/EXR-series oscilloscopes that
occurs after sending the :STOP SCPI command.

Fixes the :ASTate SCPI query so that it returns the trigger ARM state correctly.

Fixes the Duty Cycle Adjustment (DCA) measurement SCPI commands.

Adds the :TRIGger:EDGE:COUPling SCPI command to the MXR/EXR-series oscilloscopes
programming guide.

Fixes a defect in the MXR/EXR-series oscilloscopes where the plot is not rescaled after
adjusting Volts/div with the acquisition stopped.

Fixes a GUI defect in RTSA mode with the Frequency Mask Trigger “OK” button being off
screen with Touch enabled.
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= Fixes a defect in the MXR-series oscilloscopes DI0OTOPWRA Power Supply Analysis
software where the Waveform Generator was not being enabled for Bode plots.

Version 11.25.00107

Released Date: 4 Jan 2022
Operating System: Windows 10
Bug Fixes

= Fixes oscilloscope voltage range limits for probes with multiple attenuation levels including
DPOO0OTA, MX002XA, N7026A, N7000/1/2/3A, N2830/1/2A, N2820/1A, N2790A, and
N2750/1/2A.

Version 11.25.00001

Released Date: 3 Dec 2021
Operating System: Windows 10

New Features and Enhancements

= Supports Secure Instrument Communications 1.0.
» Extends the maximum number of measurements to 40. The previous maximum was 20.
= |mproves the burst interval measurement to work with only one burst on screen.
Previously, it required more than one burst to be on screen.
» Enhancements to D9OTOASIO “Infiniium Offline — Adv Signal Integrity Software” and
DIY020ASIA “Advanced Signal Integrity Software”
o Adds Infiniisim SCPI grammar for specifying port numbering and port flipping.
» Enhancements to D90TOJITO “Infiniium Offline - EZJIT Complete Software” and
D9020JITA “EZJIT Complete - Jitter and Vertical Noise analysis Software”
o To support PCle6, adds new jitter results for Uncorrelated Total Jitter, UTJ(p-p),
and Uncorrelated Deterministic Jitter Delta-Delta, UDJdd.
= Enhancements to the D90T10PAMA “Paulse Amplitude Modulation PAM-N Analysis
Software”
o Adds auto skew controls for PCIE6 CDR.
o Adds per-level SNDR Sigma-n measurements.
o Adds per-level oscilloscope random noise removal from SNDR Sigma-n
measurements.
o Adds four data patterns for PCIE6 PAM4 12-Edge jitter analysis.
= New Protocols and Protocol Enhancements
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o MIPIRFFE V3.0 (includes protocol trigger for EXR/MXR-series and decode only for
the UXR-series) - D90TOMPLP license

o UniPro 2.0 - DSOTOMPMP license
Quad SPI Analog Trigger Speed Improvement - D90T0LSSP license

New SCPI Grammar (refer to Programmer’s guide for details)

Notes

Adds SCPI grammar for the Duty Cycle Adjustment measurement.
Adds streaming support for the “:“WAVeform:DATA” SCPI command to support up to 2
Gpts waveforms.
Adds four PCIEG data patterns, following is the new SCPI syntax to accommodate this.
o :MEASure:PAM:PRBS13q:PATTern {P13Q | PCI6P1 | PCI6P2 | PCIEP3 | PCIEP4 |
FILE}
Adds a new query to get the status of the DFE taps (valid, clamped high, or clamped low).
Returns VAL, HIGH or LOW.
o :LANE<n>:EQUalizer:DFE:TAP:STATus? <tap number>
Adds new per-level SNDR Sigma-n measurements
o :MEASure:NSIGma(?) (<source>(, {IEEE | PCIE | FILE}(, <file path>(, {LO| L1 |L2 | L3
| ALLY))
Adds UDJdd and UTJ jitter results for the :MEASure:RUDJ:ALL results query.

This software installs a new version of the probe firmware for the MX0020A (10 GHz),
MX0021A (13 GHz), MX0022A (16 GHz), MX0023A (25 GHz), MX0024A (20 GHz), and
MXQ0025A (25 GHz) InfiniiMax high-speed differential probe amplifiers. After connecting
one of these probes, the user is prompted to update the probe firmware. The update takes
several minutes to complete for each probe.

Bug Fixes

Includes bug fixes from the 06.71.00001 Infiniium software release.

Fixes an intermittent issue causing a missing Host ID.

Fixes a defect preventing the loading of a .h5 waveform file from the “Open Composite
File” dialog.

Fixes a channel-channel skew error of up to ~4ps that can occur for some volts/div scale
changes.

Fixes a defect in Hardware Mask Test where false failures can occur after applying channel
skew.

Fixes a defect in Hardware Mask Test “Run Until Waveforms” where stopping occurs
before the full waveform count is reached.
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Fixes an issue in the MXR/EXR-series oscilloscopes where disk utilization goes to 100%
when the Sin(x)/x Interpolation filter is enabled.

Fixes y-marker defects in RTSA mode (Real Time Spectrum Analyzer).

Fixes Default Setup for RTSA mode (Real Time Spectrum Analyzer).

Fixes a defect with software not responding to a current probe external power being
plugged in/removed. This impacts the N2780A, N2781A, N2782A, N2783A and N7026A
current probes.

Fixes an incorrect signal level generated by the Waveform Generator for some amplitude
settings.

Fixes decoding defects in the I3C protocol decoder.

Fixes decoding defects in the JTAG protocol decoder.

Increases the maximum measurement count to prevent overflow.

Fixes the Divide math function for a constant value divided by a signal source.

For MXR/EXR-series, fixes an intermittent defect with bad data at the end of the waveform
in Roll sampling mode, with manual sample rate, after pressing Stop. This is a partial fix. If
the roll is stopped before filling the screen, there could still be bad data at the end of the
waveform.

For MXR/EXR-series, fixes an intermittent defect with time misalignment between a
channel and a math function in Roll sampling mode with manual sample rate selected.
Fixes a defect with canceling a probe calibration before the calibration is completed. This
can cause the calibration to falsely show Passed even though the calibration is incomplete.
This defect only effects the MXO020A/21A/22A/24A/25A probes.

Fixes an issue in the MXR/EXR-series preventing the voltage offset control from working
after default setup with a probe connected which supports auto probe correction.

Fixes a failure with the EZJIT Complete jitter noise calibration when non-zero voltage
termination is selected for the N7010A probe.

Fixes a defect in the MXR/EXR-series Power Analysis application which was preventing
Harmonics Test Results from being saved.

Fixes a defect with cross-correlated period measurement trend being centered about O
rather than the measurement mean value.

Fixes a defect with maximizing the oscilloscope window after minimizing.

Improves the probe calibration instructions for the MX0105A SMA probe head.

Enables loading a single waveform from an .h5 waveform file that includes multiple
waveforms.

Fixes the “:LISTer:DISPlay ON” command.

Fixes the number of transitions reported for the jitter results for “Unit Interval” display
units.

Fixes a defect with the channel scale fine control getting disabled.

Fixes a defect with adding manual markers where a Y marker is intermittently missing.
Fixes the pulse width trigger polarity. Triggering was occurring on the wrong edge slope.
Fixes AND qualified pulse width triggers for Sequence-B trigger.

10
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Fixes pulse width trigger range for Sequence-B trigger.

Known Bugs

HW Mask Test “stop on failure” does not work for channels 5-8 of the MXR/EXR series.
There is a plan to fix this in the 11.30 release.

MXR/EXR Roll Mode does not support digital channels. There is a plan to fix this in the
11.30 release.

MXR/EXR “Trigger on Search” does not support digital channels. There is a plan to fix this
in the 11.30 release.

MXR/EXR Roll sampling mode may show bad data at the end of the waveform when
manual sample rate is selected, and the roll is stopped before the screen is filled. There is
a plan to fix this in the 11.30 release.

Version 11.20.00201

Released Date: 11 Nov 2021
Operating System: Windows 10
Bug Fixes

Fixes the following issue. After running the attenuator service self test, the UXR 3.5mm
channel module configuration isn't restored properly and subsequently running a
calibration will not be accurate unless the oscilloscope application is restarted before
running the calibration.

Increases a test limit in the UXR 1.85 mm and 1.00 mm channel module service self test to
prevent false failures.

Fixes an issue with the response correction filter cache causing bad waveform data in
RTSA mode.

Fixes an issue with the MXR/EXR response correction filter cache causing an invalid filter
to be applied to the channel. This was causing a bandwidth failure during manufacturing
test.

11
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Version 11.20.00101

Released Date: 19 Oct 2021
Operating System: Windows 10
Bug Fixes

Updates “Quick Jitter” to use Arbitrary pattern length.

Fixes a defect on the MXR and EXR series causing measurements to reset when selecting a
channel.

Increases trigger hysteresis for “High-Bandwidth Trigger” on the UXR-series to prevent
triggering on oscilloscope noise for high-sensitivity volts/div settings.

Fixes a defect that prevented drawing of masks for the real time eye of a gated math
function.

Fixes a defect causing the MX0023A probe DC attenuation/offset calibration to fail with
MXOT05A and N5380 SMA probe heads.

Fixes the “Multipurpose on Trigger” feature for saving waveforms and screen images.
Fixes the “Probe Resource Center” link in the probe configuration dialog.

Version 11.20.00001

Released Date: 21 Sep 2021

Operating System: Windows 10

New Features and Enhancements for UXR-Series

New DI90T0WSAA software package
o Realtime Spectrum Analysis (RTSA) bandwidth up to 160 MHz when ordered with
UXR000-601 or UXROO0-602.
o RTSA standard bandwidth of 40 MHz.
New D9020WSAA software package
o Realtime Spectrum Analysis (RTSA) bandwidth up to 320 MHz when ordered with
UXR000-602, or up to 160 MHz when ordered with UXR000-601.
o RTSA standard bandwidth of 40 MHz.
Implements a caching scheme to reduce the time required to change volts/div, sample
rate, bandwidth and channel skew settings.
Provides N439T1EM4/5/6C license recognition on the UXR for the N4391B Optical
Modulation Analyzer.
Adds support for the MX0020A (10 GHz), MX0021A (13 GHz), MX0022A (16 GHz),
MX0024A (20 GHz), and MX0025A (25 GHz) InfiniiMax high-speed differential probe
amplifiers, all of which use the Autoprobe-2 interface.

12
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New Features and Enhancements for MXR/EXR-Series

Adds IF Magnitude Trigger which is a trigger mode that allows the user to trigger on the

Digital Down Converted signal.

Enhancement to the transient response test in the D9OTOPWRA “Power Supply Analysis
Software” to specify the overshoot in either voltage or percent and to allow a much lower
value for overshoot (current limit is 1% and new limit is less than 0.1%).

New Features and Enhancements for UXR- and MXR/EXR-Series

Enhancements to the D90OTOPAMA “Pulse Amplitude Modulation PAM-N Analysis
Software”
o Adds support for PAM6 and PAMS8 including Thresholds, Realtime Eyes, Eye
Measurements, CTLE/FFE/DFE Equalization, CDR, Jitter/Noise Measurements, and
SER.

o Adds noise removal for PAM4 12E J3U/J4U/J6U measurements.

o Enables the Vrms Area measurement (entire display) for PAM4 signals.
Enhancement to D9020JITA and DI010JITO “EZJIT Complete Software” to add a cross-
correlated period measurement to support PCle5/6.

Enhancement to D901OMCDP “MIPI CSI and DSI Protocol Decode/Trigger Software (C-
PHY and D-PHY)” to add CSI2 v3.0 over CPHY v2.0.

Enhancement to D9010OMCDP “MIPI CSl and DSI Protocol Decode/Trigger Software (C-
PHY and D-PHY)” to add CSI2 v3.0 over CPHY v2.0.

Adds hardware-accelerated Mask Test.

Adds the ability to build multiple waveforms on top of each other for Offline analysis in a
similar way to how multiple waveform acquisitions accumulate on the oscilloscope.
Adds a Total Harmonic Distortion FFT measurement.

Updates the Phase Noise application to work with mmWave Extension Bandwidth
Windows (Frequency Extension signal type).

New SCPI Grammar (refer to Programmer’s guide for details)

:FUNCtion<F>:ADEMod <source>

‘HOSTed:EOACquisition {ON | OFF}
:MEASure:RJDJ:SCOPe:RJ:CALibrate
‘MEASure:FFT:THDistortion(?) Signal,[PEAK|[MANual],Param,Peaki#
:MEASure:PN:DESKew

:‘MTESt:CPOLygons {ON | OFF}

‘MTESt:HWMask:UHWMask {ON | OFF}

‘MTESt:HWMask:ACTive?

‘MTESt:STATistics {Ul | WAVeforms | BOTH}
‘POWer:SIGNals:OVERshoot:UNITs(?) <PERCent:VOLT>

13
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:SYSTem:ERRor 293 Concave Mask (HW can't do concave polygons)

:SYSTem:ERROR 294 (Out Of HW Mask Resources)

‘WAVeform:DATA <X_origin>,<X_increment>,<Y_origin>,<Y_increment> <IEEE_block_data>
Several “:MEASure” commands and queries have been added to support PAM6 and PAM8
Several “:REPository” commands and queries have been added to support Data Analytics
(KSB800A) remote interface

The LXI Conformance Committee approved the application for UXR/MXR/EXR Scopes as
being conformant to LXI Device Specification 2016 (LXI Core 2016 Device and LXI
Extended Functions: VXI-11 Discovery and Identification, and HiSLIP) based on Self
Certification.

Updates the LXI version to CCL LXI 5.2.3 M1.

Updates the Pathwave Calibration Advisor to version 1.44.

Removes IVL restricted licenses from the demo all trial license.

Bug Fixes

Includes bug fixes from the 06.70.00007 Infiniium software release.

Adds a Charge measurement to the Mixed measurements. It was missing.

Fixes an issue with Phase Noise averaging resetting.

Fixes an issue with the waveform colors not loading properly into Offline for composite
waveforms.

Fixes an issue with the “:POWer:CLResponse:APPly” SCPI command not working the
second time it is executed.

Fixes an issue with the N280XA InfiniiMax Il probe calibration calling for the wrong fixture,
E2655 rather than MXO104A or Nb443A.

Fixes an incorrect measurement result for FFT channel power and power spectral density
for Vrms units.

Disables Differential Channels mode when the probe external scaling is different between
the two channels.

Fixes an issue where jitter measurements on waveforms saved to .bin format were showing
a phase jump.

Allows tracking RF markers for the Phase Noise plot and changes the markers enabled by
the Phase Noise Wizard to use tracking RF markers rather than X-position markers.

Fixes the loop bandwidth setting (correct value is 5 MHz) for the DisplayPort UHBR10,
UHBR13.5 and UHBR20 CDR presets.

Fixes an issue with the Trigger Event Register returning an incorrect value. This issue was
found running the D9030SATC “SATA 6Gb/s Compliance Test Application.”

Fixes an OPC (Operation Complete) query timeout issue. This issue was found running the
D90T0USBC “USB 2.0 Transmitter Compliance Test Application.”

14
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Known Bugs

HW Mask Test “stop on failure” does not work for channels 5-8 of the MXR/EXR series.
There is a plan to fix this in the 11.30 release.

MXR/EXR Roll Mode does not support digital channels. There is a plan to fix this in the
11.30 release.

MXR/EXR “Trigger on Search” does not support digital channels. There is a plan to fix this
in the 11.30 release.

Version 11.15.00203

Released Date: 4 Aug 2021
Operating System: Windows 10
Enhancements

Adds functionality to Variable Length Segmented mode to support ending the acquisition
after a user specified time. Previously, it only ended after a specified number of segments.
To reduce measurement uncertainty, this software version modifies the PAM4 12-Edge
measurements to require at least 100 patterns.

Bug Fixes

Includes several bug fixes for Ethernet 1000Base-T1 (D9020AUTP license) protocol trigger.
Reduces the pre-trigger delay added to the MSO channels. This was causing acquisitions
with MSO channels enabled to take longer to complete than expected.

Fixes a vertical scaling defect with Vertical Autoscale for channels with Infiniisim enabled.
Enables PCle Gen1 and Gen2 protocol decode for the D90T0PCIP license.

Modifies the D90TOPWRA Power Supply Test Software offset calibration to use the probe’s
offset/gain cal.

Fixes a defect causing the Infiniium software to hang when running the DS0T0SFPC SFP+
Ethernet Compliance Test Application.

Fixes a defect where the channel waveform is not plotted in differential channel mode with
Infiniisim graphs turned off. This defect only occurs when probes are connected to the
input channels.

Fixes a crash in the MIPI M-PHY UniPro Protocol decode software found running on the
MXR-series oscilloscopes.
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Version 11.75.00201

Released Date: 7 July 2021
Operating System: Windows 10
Enhancements

» Updates the Infiniium Software Updater to treat xx.xx.xxxx and x.x.x.x versions as the same
version. For example, 02.10.0014 and 2.10.14.0 are the same version.
» Updates the End User License Agreement (EULA) to version 1-July-2021 (5991-3402)

Bug Fixes

» Changes the factory default setting for the “Auto Power On” user preference to OFF for
UXR, MXR and EXR series oscilloscopes.

Version 11.15.00101

Released Date: 25 June 2021
Operating System: Windows 10
Enhancements

= Modifies the PAM4 jitter algorithm for the 12-Edge Sigma-n DataCom measurement to
work with closed eyes.

= |Improves the robustness of the PAM4 12-edge jitter measurements for closed eyes.

» Enables Ethernet 1000BaseT1 trigger (D9020AUTP license).

» Updates the MXR/EXR to recognize the PD1000-60002 probe.

Bug Fixes

» Adds Windows10 support to the Infiniium installer so that it installs VC++2013 (x86 and
x64) redistributables. These redistributables are required for some compliance test
applications.

» Fixes an issue than can potentially default the calibration factors on the UXR when
upgrading from 10.17 or older software versions to 11.15.00001.

= Fixes an issue where turning on a second channel with Infiniisim enabled can halt the
acquisition.

= Fixes an issue on the MXR/EXR where an overload can occur performing default setup with
a b0-ohm probe connected to one of the channels.

= Fixes the :CALibrate:STATus query to return the correct string for a 2-channel UXR
oscilloscope.
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= Fixes an intermittent crash that was found running PAM4 12-edge jitter measurements on
deep memory with Infiniisim enabled.

» Fixes an issue in the ““MEASure:CLOCk:METHod:OJTF” command where it was not having
an effect on the CDR settings.

= Fixes an intermittent issue on the UXR-series oscilloscopes which adds 125ps of delay to
the aux trigger path after cycling power.

Version 11.15.00007

Released Date: 21 May 2021
Operating System: Windows 10

Enhancements for UXR-Series

» Adds 2->4 channel upgrade options for the UXR-series AP models.

» Adds support for N7010A (30GHz Active Termination Adapter) and N7024A (6GHz Power
Rail Probe) for all UXR-series. Previously, these were only supported for UXR frames with
3.5mm input connectors.

= Adds CDR edge direction into the measurement setup panel for the clock TIE
measurement to simplify user setup.

* Includes several updates to PAM4 CDR, equalization and jitter to support IEEE 802.3ck
D1.4 spec and PCleb:

o New CTLE and CDR functions for PCle6

o Improves the 12E measurements to work with high BER signals

o 12E Jitter and Jrms, J4U, J6U, EOJ measurement on PRBS9Q and PClet 52-bit
pattern

o SNDR Sigma-n measurement

o Improves pattern averaging to work on closed eyes.

= New Protocol Decode Support:

o 400G FEC Decode (Included with D9OTOFECP and D9020BDLP, requires
D90T10PAMA)
o DP 2.0 Phase 1T - Aux Channel Decode

Enhancements for MXR and EXR-Series

» Adds new 1.6 Gpts Combined Flexible Memory upgrade options.
* Provides support for a new family of high-bandwidth single-ended passive probes. (Note
that Infiniium software 11.10.00202 also supports these probes):
o PPOOOTA Passive probe, Hi-Z+, 10:1, 1T GHz, 300 Vrms
o PPOO02A Passive probe, Hi-Z+, 100:1, 800 MHz, 1200 Vrms
o PPOOO3A Passive probe, Hi-Z+, MMCX interface, 10:1, T GHz, 30 Vrms
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o PPOOO4A Auto-probe 1 adapter for high bandwidth passive probes
New Protocol Decode Support:
o DP2.0Phase 1 - Aux Channel Decode and Trigger (Included with D90T0EMBP and
D9010USBP)
o FEthernet 1000BaseT1 Decode (D9020AUTP license)

New SCPI Grammar (refer to Programmer’s guide for details)

‘ANALyze:SIGNal:PATTern:INVert {ON | OFF}
:ANALyze:SIGNal:PATTern:REVerse {ON | OFF}
:MEASure:PAM:PRBS13q:PATTern {P13Q, PCI6, FILE}
:MEASure:PAM:PRBS13q:PFlLe <pattern file path>
:MEASure:PN:INFO?

Changes the UXR factory default user preference “Auto Power On” setting to ON.

Updates the packaging to include KLM 5.4 version of the Keysight License Manager.
Updates the “maximum” and “yellow maximum” counts reported to the Asset Management
software for the UXR 1.85mm and 1.00mm attenuators to be 250K and 225K respectively.
Previously, these cycle counts were 2M and 1.8M respectively. Also adds a method for
service centers to reset the attenuator cycle count.

Reduces the RTSA bandwidth enabled by the “demoall” license to T60MHz.

Bug Fixes

Fixes a timeout issue that occurs running the FlexRT Optical Dark Calibration for the
N7004A and N7005A Optical to Electrical Converters.

Fixes the measurement result shown on the MXR/EXR-series oscilloscopes when a signal
is clipped.

Fixes an issue where the Frequency Mast Trigger mask is drawn in the wrong location for
horizontal references other than 50%.

Fixes a bug preventing the uploading or more than one data set into the
K6810A/K6820A/KS6899 Pathwave Measurement Analytics.

Fixes an issue blocking transporting of licenses from a UXR/MXR/EXR-series oscilloscope.
Fixes an issue causing the incorrect memory depth to be calculated by the PAM4 wizard
when jitter/noise is not selected.

Fixes an issue that was blocking measurement statistics in the Output Ripple measurement
when the histogram is enabled for the MXR/EXR Power Application.

Fixes an issue with vertical autoscale not scaling the signal properly when Infiniisim is
enabled with a transfer function which has a gain greater than one.
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Fixes an issue in the Infiniium installer where an error message is displayed indicating that
the Wibukey.dll cannot be installed properly.

Fixes issues with the ““WGEN:PRBS:LENGth” SCPI command.

Fixes the UXR keyboard selftest to include the Aux trigger button.

Fixes a failure occurring in the skew calibration for the N2830A probe.

Reduces the time required on the MX0023A InfiniiMax 25 GHz RC probe to change the
attenuation setting.

Version 11.70.00202

Released Date: 9 April 2021
Operating System: Windows 10
Enhancements

Modifies the jitter algorithm for 12-Edge measurements to use Time Interval Error rather
than measuring edge jitter from the start of the waveform. This reduces the measured jitter
for some waveforms.

Adds SCPI support for RS-232 / UART serial decoding.

Provides a popup dialog to update the MX0023A probe firmware when a probe with out-
of-date firmware is connected to the oscilloscope. Using MX0023A probes with out-of-
date probe firmware can result in long delays when attaching the probe or when changing
attenuation setting. The most current version of MX0023A probe firmware is 6.4.

Allows D9020BDLP “Complete Infiniiium Protocol Trigger/Decode Bundle” on the MXR and
EXR series.

Bug Fixes

Fixes an issue with the FFT display disappearing for Center Frequencies > T0GHz on a
Digital Down Converted waveform.

Fixes an issue with the Host ID not being detected after cycling power.

Fixes a false failure of the acquisition memory self test.

Fixes an issue with the Power Spectral Density measurement showing “-N.N” result when
Vrms units are selected for an FFT Magnitude function.

Fixes an issue in the Infinilum Software Updater showing “Compatibility Issues” for the
DI9030SATC SATAGG Test App.

Fixes an issue with the phase noise application, the carrier power was calculated with the
wrong reference impedance in differential channel mode. It was calculated with 50 ohms
but should be calculated with 100 ohms.
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Fixes an issue switching to RTSA (Real Time Spectrum Analyzer) mode. An error message
was reported, “This entry isn’t a valid selection. The sampling mode control has not been
modified.”

Fixes the autoset feature for PAM-4 thresholds. Autoset was not working when the existing
threshold levels were outside of the eye.

Fixes a crash that could occur when reordering measurements using “move up” and “move
down”.

Fixes an issue where the oscilloscope application could crash after selecting File->Exit.

Version 11.70.00105

Released Date: 12 March 2021

Operating System: Windows 10

Enhancements for UXR-Series

Adds CTLE presets and bth order PLL to support PCle 5.0
Adds a variable length segmented mode for use by the PathWave Vector Signal Analysis
(89600 VSA) software for RADAR DRFM/Jammer test.
Adds IF magnitude trigger for use with Digital Down Conversion.
Adds software Zone Trigger support for the following functions, FFT Magnitude, Multiply
and Equalization. The main driver for this feature is to do Zone Trigger on the post-DFE
equalization lane signal for DDRb.
Adds a new measurement called “Duty Cycle Adjustment” to support the DDR5
compliance test application. This is a set of measurements requested by DDR5 customers
who need to evaluate the duty cycle of each “phase” of the DQS (strobe) signal.
Adds multi-channel mask test up to 8 channels for the UXR series. This feature is already
available for the MXR and EXR series.
Adds history mode for the UXR series. This feature is already available for the MXR and
EXR series.
Adds 8 waveform memories for the UXR series. This feature is already available for the
MXR and EXR series.
Adds Fault Hunter for the UXR series. This feature is already available for the MXR and
EXR series.
New Protocol Decode Support:

o PCle Gen 5 (D9010PCIP license)

o USB4 - Tunneling USB3.2 (D9010USBP license)

o USB4 - Tunneling PCle3.1 (D9010USBP license)
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Enhancements for MXR- and EXR-Series

Adds software Zone Trigger support for FFT Magnitude and Multiply functions.
Provides basic MultiScope support.

Increases the maximum number of segments per channel to 3T1K. Previously it was 5K.
New Protocol Decode Support:

USB4 LS Trigger (D9010USBP license)

MDIO Decode/Trigger (D9010EMBP and D90T0BDLP licenses)

RFFE Hardware Trigger (D9010MPLP license)

SVID Spec Rev (v1.93, VR14) (D90T0LSSP license)

O O O O

Other Enhancements for UXR-, MXR-, and EXR-Series

Adds a new calibration service feature called the “Pathwave Calibration Advisor”, to remind
customers when calibration is due and to make is easy to request calibration service.
These reminders can be turned off for customers who do not want this feature.
Accelerates the runtime speed of the EZJIT jitter analysis software. The greatest
acceleration occurs when running Periodic mode, using Spectral RJ separation. Other
modes like Random mode and Tail-fit will also receive some acceleration.
Adds the ability to measure eye width and eye jitter in Ul units. Refer to Help and the
Programmer’s guide for more information.
Adds a 60dB/Decade filter shape for the TIE Filter accessed from the Advanced tab in the
Jitter/Noise Setup dialog.
Some improvements have been made for screen capture. The time to render an inverted
screen capture has been accelerated. The Platinum theme has been reworked to fix
inverted-screen printing issues.
Adds a new check box in the Display setup dialog to enable/disable the Color Grade
Legend. Also adds remote SCPI grammar to support this.

o :DISPLay:CGRade:LEGend <ON|OFF>

o :Diplay:CGRade:LEGend?
Adds SCPI grammar for saving a measurement report. The report can be saved as PDF or
MHTML format.

o :DISK:SAVE:MREPort <filename.pdfimht>
Adds SCPI grammar for reordering measurements within the results table.

o :MEASurement<1-20>:POSition <1-20>

o :MEASurement<1-20>: POSition?
Adds SCPI grammar for specifying the layout format to be used to organize grids in the
waveform area.

o :DISPlay:GRATicule:GLAYout{SVERtical | SHORizontal | TVERtical | THORizontal},

[<area>]
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Notes

= For safety reasons, the maximum high-impedance voltage offset for the MXR and EXR
series is reduced to +/-40 V. Previously, it was +/100 V.

Bug Fixes

= Fixes an issue with the hardware assisted jitter results de-converging for transitions
greater than 10M.

= Reduces the probe offset error resulting from the Gain/Offset probe calibration for the
N7000A-3A InfiniiMax Ill+ probes.

» Fixes a bug in the SVID protocol decoder falsely triggering on an error type of “End Pattern
Error”.

= Fixes a bug with delta Y markers that was found on the MXR 8-channel oscilloscope.

= Fixes a mapping bug in the Utilities > Front Panel Sources feature.

= Fixes the MXR-Series/EXR-Series front-panel Touch button behavior

= Fixes bugs in the Precision Cable/Probe feature.

» Fixes a bug with the wrong date being saved for the :WAVeform:PREamble query and for
the Multipurpose quick save feature.

Version 11.06.00501 (MXR/EXR-Series)

Released Date: 6 January 2021
Operating System: Windows 10
Notes

= Protocol trigger on search for digital channels is not available

Bug Fixes

» Fixes an issue impacting the VSA software. The Spectral center frequency resolution is too
coarse causing a rotation error in VSA up to 50 KHz.

Version 11.06.00401 (MXR/EXR-Series)

Released Date: 17 November 2020
Operating System: Windows 10
Notes

= Protocol trigger on search for digital channels is not available

22



Infiniium UXR/MXR/EXR-Series Oscilloscope Software Release Notes

Bug Fixes

» Fixed slow trigger rate when using HRO mode

= Fixed issue with D9OT0JITA and DIOTOSCNA licenses not being recognized

= Fixed issue with RTSA color scheme changing on loading a setup multiple times

» Fixed issue where FMT does not appear on screen or appears in the wrong position

= Fixed issue with DDC 2GHz span not working with 500MHz and 1GHz models

= Fixed issue with :MEASURE:THRESHOLDS:PERCENT not accepting some valid values
= Fixed a performance issue saving segmented data

Version 11.05.00801 (MXR-Series)

Released Date: 2 September 2020
Operating System: Windows 10
Enhancements

= Added arbitrary waveform generator editor

Notes

* Protocol trigger on search for digital channels is not available
Bug Fixes

= Fixed issue with RTSA on channels 5-8
» Fixed issue with N2820A and N2821A probes

Version 11.05.00602 (MXR-Series)

Released Date: 31 July 2020
Operating System: Windows 10
Notes

» Protocol trigger on search for digital channels is not available

Bug Fixes

» Fixed intermittent hardware initialization failures
» Fixed time tags not appearing during segmented acquisitions with HW DDC

23



Infiniium UXR/MXR/EXR-Series Oscilloscope Software Release Notes

Version 11.05.00514 (MXR-Series)

Released Date: 26 June 2020
Operating System: Windows 10
Enhancements

» Added Real Time Spectrum Analyzer (RTSA)

» Added Frequency Mask Trigger for RTSA

» Added HW DDC

» Added frequency extension for HW DDC

» Added support for protocols on channels 5-8 when a protocol uses more than 4 channels
» Added support for MIPI DPHY 4 lanes with clock channel

» Added support for new D9011BDLP protocol bundle

Notes

= Protocol trigger on search for digital channels is not available

Version 11.00.02105 (Initial Release, MXR-Series)

Released Date: 27 May 2020
Operating System: Windows 10

Version 10.25.01202 (Patch 6, UXR-Series)

Released Date: 18 December 2020
Operating System: Windows 10
Bug Fixes

- Reduces the time to initialize the MX0023A probe when it is connected to an oscilloscope
channel.

- Fixes FFE auto set taps when a pattern is specified in the Signal Type setup panel.

- Fixes an Infiniisim issue that occurs when enabling the display graphs. The Infiniisim
transfer function was not applied properly to the channel.

- Fixes an issue impacting the VSA software. The Spectral center frequency resolution is too
coarse causing a rotation error in VSA up to 500 KHz.

- Reduces the time required to switch attenuator range in the MX0023A probe.

- Fixes an issue causing questionable rise/fall time measurements on a PAM4 Realtime Eye.

- Fixes an issue preventing the channel BW limit filter from being applied to measurement
data when Fast Plot is enabled.
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- Fixes an issue found by the M8070B software when connected to the UXR oscilloscope as
a Realtime Error Detector. This issue was causing a high BER with PAM4 line coding.

- Fixes an issue causing time shifts in the waveform data, for channel bandwidths set below
11.9GHz, found while running Precision Cable.

- Fixes an issue in the UXR software causing zero-valued Rj measurement results found
while running the D902THDMC HDMI compliance application.

Version 10.25.01104 (Patch 5, UXR-Series)

Released Date: 17 November 2020
Operating System: Windows 10
Enhancements

- Speeds up saving segmented waveforms to a file and offloading segmented waveforms.
- Adds a de-skew feature for the Keysight A400GE-QDD test system using the UXR
oscilloscope to support SSPRQ100 test patterns.
- Adds support for a new 10GHz, 4-channel UXR model
o UXROT04A Infinilum UXR Real-Time Oscilloscope, 10 GHz, 128 GSa/s, 4Ch
o N2129BU-020 Bandwidth upgrade — 4Ch Infiniium UXR Real-Time Oscilloscope
10 GHz to 13 GHz
- Adds support for new mmWave Wideband Analsysis Acceleration and Extension
Options/Upgrades
o N2163A-082 5 GHz Configurable mmWave Extension Badnwidth Window - DC to
82 GHz Frequency Range
o N2163A-083 Upgrade Maximum Frequency for 5 GHz mmWave Extension
Bandwidth Window from 82 GHz to 110 GHz
o N2163A-020 Upgrade 10 GHz to 20 GHz Configurable mmWave Extension
Bandwidth Window
o N2163A-030 Upgrade 20 GHz to 30 GHz Configurable mmWave Extension
Bandwidth Window
- Adds support for new mmWave Factory Installed Options
o UXR0000-682 5 GHz Configurable mmWave Extension Bandwidth Window - DC
to 82GHz Frequency Range
o UXR0000-620 20GHz Configurable mmWave Extension Bandwidth Window
o UXR0000-630 30GHz Configurable mmWave Extension Bandwidth Window
- Adds support to launch the FlexRT software from within the UXR GUI. The FlexRT software
adds the TDECQ optical measurement to the UXR series oscilloscopes.
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Bug Fixes

- Fixes the :CHANnel<N>:PROBe <attenuation_factor>[,\{RATio | DECibel}] command.
- Fixes an issue causing the D9040EDPV eDP compliance test application to abort the Peak-

to-Peak voltage tests.
- Fixes a performance issue within the UXR when connected to the N4391B Optical

Modulation Analyzer.

Version 10.25.01003 (Patch 4, UXR-Series)

Released Date: 26 October 2020
Operating System: Windows 10
Bug Fixes

- Fixes an issue causing the oscilloscope to hang when the MX0023A probe is disconnected
from a channel.

- Replaces the “Long Operation” message with a more descriptive message when the
MX0023A probe is connected to a channel. The new message is “MX0023A probe
detected, computing probe transfer function which will take a minute.”

Version 10.25.01001 (Patch 3, UXR-Series)

Released Date: 12 October 2020
Operating System: Windows 10
Bug Fixes

- Fixes the optical power measurement gain for the N7005A 60GHz O/E Converter.
- Fixes an infinite jitter measurement result being reported to the D9040DPPC Display Port
Compliance Test Application.
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Version 10.25.00902 (Patch 2, UXR-Series)

Released Date: 17 September 2020
Operating System: Windows 10
Enhancements

Adds PMAX-Normalized (PRBS13Q) algorithm for computing DFE taps to the Equalization
Auto Tap Setup dialog.

Reduces the minimum OJTF Loop Bandwidth for PAM4 CDR to TMHz.

Adds probe bandwidth to the CHAN<X>:PROBE:INFO? Query

Improves the performance of the SCPI :WAVeform:SEGMented:XLISt? query.

Bug Fixes

Notes

Fixes a UXR software issue with running the M8070B System Software in the Real Time
Error Detector configuration.
Fixes the DC Offset/Gain Cal for the MX0023A InfiniiMax 25 GHz RC probe with MX0105A
SMA probe head.
Fixes an issue causing “A long operation is occurring” message to appear when connecting
the MX0023A InfiniiMax 25 GHz RC probe to the oscilloscope channel.
Fixes a crash when sending the SCPI query, :MEASure:PAM:PRBS13qg:EDGE:EOQJ?
Fixes an issue where the Protocol listing display does not automatically go to the trigger
point after a trigger event even though the waveform does.
Fixes several issues with UXR Multiscope when hosted from a PC.
Fixes an issue with colorgrade of a differential waveform showing two waveforms shifted in
time.
Fixes defects effecting the following compliance test applications:

o D9Y040DPPC Display Port

o D9040EDPV eDP

o D9010EBZC T0GBASE-T Ethernet

o D9021HDMC HDMI

Includes features and bug fixes from the 6.55.00902 Infiniium Oscilloscope software. Refer
to the release notes for this software versions for more details,

https://www keysight.com/main/software jspx?ckey=2488819&lc=eng&cc=US&nid=-
11143.0.00&id=2488819.
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Version 10.25.00702 (Patch 1, UXR-Series)

Released Date: 17 July 2020
Operating System: Windows 10
Enhancements

Provides support for the N7005A 60GHz O/E Converter.

Bug Fixes

Fixes issues impacting the BitifEye N5991 HDMI 2.1 Receiver Test including Data Jitter
Calibration and Cable Inter-Pair Skew Test failures.

Fixes an issue causing the UXR to hang while running the BitifEye N5991 USB4 1.1
Receiver Test.

Fixes the Auto Deskew feature for differential channels when running with a channel
bandwidth filter enabled.

Fixes an issue restoring the default setup behavior for channel voltage units after running
the N7004A O/E Converter dark cal.

Fixes an issue when selecting a Current probe. It was always selecting N7019A.

Fixes the control button functions for the N2750A/51A/52A InfiniiMode Differential Active
Probes.

Fixes an issue with loading a composite file saved from a differential channel waveform.
Sometimes, only part of the waveform was loaded.

Fixes an issue with incorrectly reporting dynamic range when using the N5449A High
Impedance adapter.

Fixes the deskew channel control in the Phase Noise application setup wizard. It was
failing for cases when the edge direction was set to Both.

Fixes the Help->"Check for Updates...” feature. A message box would pop up displaying
that "C:\Program Files\Keysight\Infinium\Apps\SwUpdater\Download\LatestAppinfo.xm!"
is missing.

Fixes an issue preventing an AC Gain setting great than 1 for CTLE equalization.

Fixes an issue with the Auto Setup feature for the MIPI D-PHY Protocol Decode application
causing ADC clipping. Changing the voltage offset to eliminate the clipping caused the
decoder to quite decoding or worse, the oscilloscope application to crash.

Fixes an issue where the lane index was not being setup properly for in-place DFE.
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Includes features and bug fixes from the 6.55.00702 Infiniium Oscilloscope software. Refer

Version 10.25.00607 (Release, UXR-Series)

Released Date: 15 June 2020
Operating System: Windows 10
Enhancements

Includes features and bug fixes from the 6.55.00401 and 6.55.00504 Infiniium Oscilloscope
software. Refer to the release notes for these software versions for more details,

Changes the reported oscilloscope temperature as a delta from the calibration
temperature rather than as an absolute temperature.

Adds enhancements to support 802.3ck/OIF Reference Receiver. These include (1) 3-pole,
2-zero CTLE’s with multiple gain stages, (2) 4’th order Butterworth noise reduction filter,
(8) new CTL presets and (4) Vertical Eye Closure measurement.

Adds N2129RU bandwidth and memory options available to select rental partners.

Adds support for the D9020BDLP protocol bundle.

Increases the maximum bandwidth setting for the UXRO702AP and UXR0704AP models to
73.5GHz. Previously, the maximum bandwidth setting was 70GHz.

Bug Fixes

Fixes bugs impacting the D90TOEBSC IEEE 802.6 compliance test application.

Fixes a TIE filter error found when running the DisplayPort compliance test application.
Fixes an eye diagram screen shot issue found when running the D-PHY compliance
application.

Fixes a probe head selection bug.

Fixes an issue in PCle protocol decode with TS2 packets being labeled as “Unknown
Packet.”

Prevents the “Offline” oscilloscope application installed on a PC from starting automatically
after an OS reboot.
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Version 10.20.00703 (Patch Release, UXR-Series)

Released Date: 28 May 2020
Operating System: Windows 10
Enhancements

Clamps the Sin(x)/x Auto interpolation factor to a maximum of 16:1 to improve
performance. Still allows a manual setting of 32:1 for applications that require it.

Bug Fixes

Provides bug fixes impacting several compliance Tx test applications including HDMI, PCle,
SFP+, SATA, SAS, MIPI, C-PHY, D-PHY, M-PHY, Ethernet, eDP, and DDRA4.

Provides bug fixes for some Rx compliance test solutions including MIPI, HDMI, and C-
PHY.

Fixes an issue that can cause waveform distortion when running with differential channels
combined with Infiniisim, BW limit or equalization. This distortion can also impact jitter
measurement results.

Fixes an issue causing PAM4 jitter measurement results and histograms to degrade with
setting changes.

Fixes in incorrectly labeled Infiniisim transfer function graph when using adjacent
differential channels.

Fixes a trigger jitter test failure found during manufacturing performance verification.
Fixes an issue causing information messages to show up in the screen shots.

Version 10.20.00503 (Patch Release, UXR-Series)

Released Date: 27 Mar 2020
Operating System: Windows 10
Bug Fixes

Sets the standard memory depth to 200Mpts. For 10.20.00501, it was defaulting to
10Mpts.

Fixes an Infiniium Offline crash occurring near the end of the oscilloscope start up
sequence. This crash occurs for installations of 10.20.00501 on a PC that already had a
6.xx version of Offline installed.
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Version 10.20.00501 (Release, UXR-Series)

Released Date: 13 Mar 2020
Operating System: Windows 10
Enhancements

Includes the features and bug fixes from the 6.40 Infiniium oscilloscope software.
Includes the features and bug fixes from the 6.50 Infiniium oscilloscope software.

Adds Multiscope support (standard feature, no license required) to connect up to 10
frames (40 channels).

Adds support for the UXRO05TAP model (1-channel, Tmm input, 5GHz BW) targeted for
mmWave analysis.

Adds support for the DPOOO1A Differential probe 400 MHz 2000V.

The behavior of the ":CHAN<N>:ISIM:STATe <State>" command is changing to improve
Infiniisim performance. The new behavior is to disable Infiniisim graphs when the Infiniisim
state is set to ON, which enables hardware acceleration of Infiniisim.

Makes 3rd order PLL CDR standard. Before it was only available with the Thunderbolt
compliance test application.

Bug Fixes

Notes

Fixes the Menu button on the N7003A InfiniiMax Ill probe.

Fixes a signal integrity issue with differential channels where one leg of the differential
channel was getting the wrong DC voltage gain factor correction applied. This problem
only occurred for a few of the volts/div settings. The symptom could exhibit some
distortion of the differential signal and a small Vpp error of less than 5%.

Fixes a hardware CDR issue found running 480 Mb/s 1010 pattern where the CDR is
unable to recover the clock. This issue only occurred when the RTE was not being plotted.
Fixes an issue where the real time eye is plotted and measured incorrectly with the
“Infiniisim Display Graphs” option disabled.

Fixes a bi-modal jitter issue on differential channel waveforms when the “Fast Plot” option
is disabled.

This version of software is updated to support compliance test applications that have been
updated to run on 2-channel UXR models.

This software version has not been fully tested and confirmed to work with all the
compliance test applications. A newer version of 10.20 will be available once this testing is
complete.
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With this software version, the UXRO000-OHW “Infiniium UXR Real-Time Oscilloscope
Hardware Acceleration upgrade - Included” license, is no longer required to enable
hardware acceleration. The license can still be installed but the software ignores it.

The revision for the “.wfm” file format is incremented to SIG_REV_L. The “.wfm” format
changed with the UXR 10.00 release but the revision was not updated to reflect the
change. This oversight is corrected with this release. This change is necessary to provide
“.wfm” compatibility between Infiniium oscilloscopes. Version 06.55 or newer is required
for A/X/S/V//Z series Infiniium oscilloscopes to be compatible with 10.20 “.wfm” files.

Version 10.12.05302 (Patch Release, UXR-Series)

Released Date: 31 Jan 2020
Operating System: Windows 10
Bug Fixes

Notes

Fixes an issue with 59GHz factory installed bandwidth licenses (UXRO592A,
UXR0594A, UXR0592AP, UXR0594AP) not being recognized.

Fixes an issue with the *OPC (operation complete) query timing out. This issue is
causing some compliance test applications to time out during execution.

The 10.12.05302 version is not compatible with all compliance test applications. Please
upgrade to 10.20.0xxxx when it becomes available or downgrade to 10.11.05004 if
running one of the following test applications:

o D9010ETHC Ethernet TOM/100M/1G

o D9010EBZC 10GBASE-T Ethernet

o DI9030SATC SATABG

. DI90T0USBC USB 2.0

o D9040DPPC DisplayPort
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Version 10.12.05208 (UXR-Series)

Released Date: 12 Dec 2019
Operating System: Windows 10
Enhancements

Adds support for Hardware Accelerated Digital Down Conversion.
o The standard software without a license provides 40MHz bandwidth.

. The standalone license, UXRO000-601, and upgrade option, N2163A-601,

provides 40 MHz to 160 MHz bandwidth.

. The standalone license, UXRO000-602, and upgrade option, N2163A-602,

provides 40 MHz to 2 GHz bandwidth.
Add support for the mmWave Wideband Analsysis Acceleration and Extension
Package, UXROO00-MWA. This package includes
. UXR0000-02G (2 Gpt memory option)
° UXR0000-610 (10 GHz mmWave Extension option)
o UXR0000-602 (2 GHz bandwidth DDC option).

Bug Fixes

Notes

Fixes issues with the differential channel auto de-skew control. It now works properly

when the oscilloscope is stopped and it works properly for input signals with DC offset.

Fixes an issue where the oscilloscope app was crashing on startup after installing the

Equalization license.

The 10.12.05208 version is not compatible with all compliance test applications. Please

upgrade to 10.20.0xxxx when it becomes available or downgrade to 10.11.05004 if

running one of the following test applications:
o D9010ETHC Ethernet TOM/100M/1G
o D9010EBZC 10GBASE-T Ethernet

o DI9030SATC SATAGG

. DI90T0USBC USB 2.0

. D9010CPHC MIPI C-PHY
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Version 10.11.05004 (Patch Release, UXR-Series)

Released Date: 14 Oct 2019
Operating System: Windows 10
Enhancements

- Improves the usability of the optional timebase calibration to (1) set the default to “not
run”, (2) make it clearer that an external 10MHz frequency reference is required, and
(3) allow the user to skip the timebase calibration, which occurs at the end of the
calibration, without impacting the rest of the calibration.

Bug Fixes

- Fixes some issues with adjusting and applying channel-channel skew.

- Fixes the bandwidth upgrade license for up upgrade on a UXR AP model from 59GHz
to 70GHz.

- Fixes a licensing issue where the license could disappear while running the
oscilloscope and then reappear after restarting the oscilloscope.

- Fixes an issue where the real time eye was resetting when doing operations such as
turning on/off the histogram or adding/deleting a measurement.

- Fixes an issue where the oscilloscope application was crashing when disconnecting the
N7010A probe from a channel input.

- Fixes a CDR loss-of-lock issue when running the Display Port compliance application
for 2MHz and lower SJ frequencies.

- Fixes a DFE equalization issue where the taps were only having half of the intended
effect.

- Fixes an equalization issue where DFE was not being applied if CTLE or FFE
equalization was also enabled.

- Fixes an issue where running the self test was leaving the oscilloscope in a bad state
causing additional baseline noise and spurs in the FFT.
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Version 10.11.04711 (UXR-Series)

Released Date: 22 Jul 2019
Operating System: Windows 10
Notes

- This software version updates FPGA firmware, which takes several minutes, and
requires unplugging the power cord to complete the update.

Enhancements

- Modifies the channel-channel skew calibration to correct for more vertical ranges.

- Hardware accelerates explicit-clock clock recovery.

- Adds a simple phase noise demo file.

- Removes the internal temperature report from the Help->About dialog.

- Sets the default to “OFF” for the “Display Infiniisim Graphs” control to enable hardware
acceleration of Infiniisim by default.

- Adds the PAM3 demo.

- Adds the USB 3.2 demos.

- Adds an “Auto Power On” user preference to automatically restart the oscilloscope
after input power has been removed and then reapplied.

- For install packages that update the power monitor/control FPGA, such as 10.11, this
software adds a new message at the end of the software install process requesting the
user to physically disconnect and then reconnect the power cord.

Bug Fixes

- Fixes some issues with adjusting and applying channel-channel skew.

- Fixes a phase shift in the trigger position caused by enabling a differential channel
(CSG-14828).

- Fixes an issue preventing the “Precision Cable” feature from being enabled.

- Fixes defects blocking the following compliance apps, D-PHY, DDR2 and USBS.

- Reduces the input sensitivity to voltage overload for UXR models with 1.85mm and
Tmm inputs.

- Fixes an invalid VISA address reported by 10 Libs when connecting with USB.

- Fixes an issue preventing the tracking of life cycle information for number of power
cycles and power-on time.

- Fixes a hardware plotting issue that occurs intermittently for deep records when a Real
Time Eye is also being displayed and most of the data is on screen. When this issue
occurs, the data plotted is corrupted and/or the plotter locks up.
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- Fixes a filter delay issue causing a bad data result when running hardware accelerated
FFE/CTLE equalization on a differential channel.

Version 10.10.04601 (Patch Release, UXR-Series)

Released Date: 11 Jun 2019
Operating System: Windows 10
Bug Fixes

- Fixes a waveform data corruption issue that occurs for differential channels and 4-port
InfiniiSim. This issue is most noticeable with signal input frequencies that are 1/8,
1716, 1/32, ..., 1/2”°N of the sampling rate.

- Reduces the input sensitivity to voltage overload for UXR models with 1.85mm and
Tmm inputs.

Version 10.10.04514 (UXR-Series)

Released Date: 20 May 2019
Operating System: Windows 10
Enhancements

- Supports all UXR models.
- Adds licenses and upgrades for the following new UXR models.
o UXR0252AP, UXR0254AP, UXRO402AP, UXRO404AP, UXRO702AP, UXRO704AP
- Adds support for the N2852A AP3->AP2 probe adaptor.
- Adds licenses and upgrades for the “mmWave Configurable Bandwidth Window”
feature.
o UXR0000-605 “5 GHz mmWave Configurable Bandwidth Window”
o UXR0000-610 “10 GHz mmWave Configurable Bandwidth Window”
- Adds precision probe and precision cable support for the UXR models with 1.85mm
and 1.00mm inputs.
- Adds hardware acceleration for the following features:
o Differential channels
o 4-port Infiniisim
o FFE and CTLE equalization
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Version 10.05.04305 (UXR-Series)

Released Date: 8 Mar 2019
Operating System: Windows 10
Enhancements

- Adds support for UXR-Series oscilloscopes with 40 GHz of bandwidth or greater.

Version 10.00.04201 (Patch Release, UXR-Series)

Released Date: 26 Feb 2019
Operating System: Windows 10
Bug Fixes

- Fixes an issue in the Help-About dialog which was showing an incorrect model
number.

Version 10.00.04104 (Patch Release, UXR-Series)

Released Date: 31 Jan 2019
Operating System: Windows 10
Enhancements

- Adds support to read the calibration data from the N2127A calibration module and
utilize this data to improve the magnitude and phase response calibration.

- Supports the free license which enables hardware acceleration for clock data recovery
and real time eye plotting.

- Provides support for Rev. 7 oscillator boards.

- Provides T00MHz as an available calibration output signal.

Bug Fixes

- Fixes a touch screen focus issue which can render the touch screen inoperative until
the scope app is iconified and restored.

- Fixes an intermittent issue that can cause the power supply to shut down due to an
erroneous overheating indicator.

- Fixes “Quick Jitter” available from the Analyze pulldown menu.

- Fixes auto set thresholds in the Crosstalk wizard.

- Fixes an issue where no signal is acquired when running a mask with 1 waveform.
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Fixes an issue where saving on “osc” file type resets the number of real-time eye
waveforms to one.

Speeds up the acquisition and downloading of short waveform data records.
Fixes an FFT error that occurs at low frequency with averaging enabled.
Fixes a “Data Out of Range” error occurring at oscilloscope startup.

Fixes the Pattern Average math function.

Fixes auto-zero inconsistent results with the N7026A probe.

Fixes issues causing failures in the following compliance applications:
Nb5412 SAS

N6472A IEEE 802.3 bs/cd

N5411 SATA

DDRb5 TX Validation

U7232 DisplayPort

N6469 eDP1.4

O O O O O O

Version 10.00.03902 (Patch Release, UXR-Series)

Released Date: 21 Nov 2018
Operating System: Windows 10
Bug Fixes

Fixes an issue that was reducing the maximum memory depth to less than 1T00Mpts.
Fixes an input overload issue that was occurring during probe calibration.

Fixes issues impacting the Display Port, Embedded Display Port, Ethernet, DDR4, and
PAM4 compliance applications.

Fixes a defect leaving the touch screen disabled after the scope application is exited.
Provides software support for the N7024A probe.

Fixes the DC Gain/Offset calibration for the N7000A, N7000TA, N70002A, N70003A,
N2830A, N283TA and N2832A probes.

Adds an update for the Keysight license manager, 6.0.2, to fix dongle-based licenses.
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Version 10.00.03801 (Patch Release, UXR-Series)

Released Date: 03 0ct 2018
Operating System: Windows 10
Bug Fixes

- Fixes external probe scaling.

- Fixes an issue causing the DDR4 compliance application to fail.

- Fixes an issue causing the SAS4 compliance application to fail.

- Fixes an issue with probe correction filters not being removed when the probe is removed.
- Fixes vertical autoscale of a differential channel waveform.

- Fixes an issue where the Infiniium app remains active after exiting.

- Fixes a precision probe calibration issue.

- Fixes a touch screen focus issue where touch loses focus with the oscilloscope application.

Version 10.00.03709 (Patch Release, UXR-Series)

Released Date: 14 Sep 2018
Operating System: Windows 10
Bug Fixes

- Fixes an install issue found at AMC with the setup.exe file.
- Fixes two BW limit filter issues (WIT 557903 and WIT 557921)

Version 10.00.03708 (Initial Release, UXR-Series)

Released Date: 13 Sep 2018
Operating System: Windows 10
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